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Inleiding

Dit document beschrijft hoe u de Cisco security applicaties ASA/PIX 7.2 kunt configureren met
reguliere expressies met modulair beleidskader (MPF) om bepaalde websites (URL's) te
blokkeren.

Opmerking: deze configuratie blokkeert niet alle toepassingsdownloads. Voor betrouwbare
bestandsblokken moet een speciaal apparaat, zoals Websensor, enz. of module, zoals de CSC-
module voor de ASA, worden gebruikt.

HTTPS-filtering wordt niet ondersteund op ASA. ASA kan geen diepe pakketinspectie of inspectie
doen op basis van regelmatige expressie voor HTTPS-verkeer, omdat de inhoud van pakket
versleuteld is (SSL).

Voorwaarden

Vereisten



Dit document gaat ervan uit dat Cisco security applicatie is geconfigureerd en correct werkt.

Gebruikte componenten

Cisco 5500 Series adaptieve security applicatie (ASA) die draait op softwareversie 7.2(2)●

Cisco Adaptieve Security Adapter Manager (ASDM) versie 5.2(2) voor ASA 7.2(2)●

De informatie in dit document is gebaseerd op de apparaten in een specifieke
laboratoriumomgeving. Alle apparaten die in dit document worden beschreven, hadden een
opgeschoonde (standaard)configuratie. Als uw netwerk live is, moet u de potentiële impact van
elke opdracht begrijpen.

Verwante producten

Deze configuratie kan ook worden gebruikt met Cisco 500 Series PIX die softwareversie 7.2(2)
uitvoeren.

Conventies

Raadpleeg de Cisco Technical Tips Convention voor meer informatie over documentconventies.

Achtergrondinformatie

Overzicht van het beleidskader

MPF biedt een consistente en flexibele manier om de functies van security applicaties te
configureren. U kunt bijvoorbeeld MPF gebruiken om een tijdelijke configuratie te maken die
specifiek is voor een bepaalde TCP-toepassing, in tegenstelling tot een configuratie die van
toepassing is op alle TCP-toepassingen.

MPF ondersteunt deze functies:

TCP-normalisatie, TCP- en UDP-verbindingslimieten en -onderbreking, en TCP-
sequentienummer-randomisatie

●

CSC●

Toepassingscontrole●

IPS●

QoS-input-toezicht●

QoS-uitvoertoezicht●

QoS-prioriteitswachtrij●

De samenstelling van het MPF bestaat uit vier taken:

Identificeer Layer 3 en 4 verkeer waarop u acties wilt toepassen. Raadpleeg het Identificeren
van verkeer met een Layer 3/4 Class Map voor meer informatie.

1.

(Uitsluitend voor de inspectie van toepassingen) Vaststellen van speciale maatregelen voor
het verkeer van de inspectie van toepassingen. Zie Speciale acties voor
Toepassingsinspecties configureren voor meer informatie.

2.

Toepassen acties op Layer 3 en 4 verkeer. Raadpleeg Handelingen definiëren met een
Layer 3/4 beleidskaart voor meer informatie.

3.
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Activeert de acties op een interface. Raadpleeg het gedeelte Layer 3/4-beleid toepassen op
een interface met een servicebeleid voor meer informatie.

4.

Normale expressie

Een reguliere expressie komt overeen met tekst strings letterlijk als een exacte string, of met
metacharacters, zodat je meerdere varianten van een tekststring kunt vergelijken. U kunt
gebruikmaken van een reguliere expressie om de inhoud van bepaalde toepassingsverkeer aan te
passen. U kunt bijvoorbeeld een URL-string in een HTTP-pakket matchen.

Opmerking: Gebruik Ctrl+V om alle speciale tekens in de CLI te verwijderen, zoals een vraagteken
(?) of tab. Bijvoorbeeld, type d[Ctrl+V]g om d?g in de configuratie in te voeren.

Om een reguliere expressie te maken, gebruikt u de opdracht regex, die kan worden gebruikt voor
verschillende functies waarvoor tekst moet worden aangepast. U kunt bijvoorbeeld speciale acties
voor toepassingsinspectie configureren met een modulair beleidskader met een inspectiepatroon
(zie de opdracht beleidsplan-type inspectie). In de kaart van het inspectiebeleid, kunt u het verkeer
identificeren waarop u wilt reageren als u een kaart van de inspectieklasse maakt die één of meer
overeenkomende opdrachten bevat, of u kunt wedstrijdopdrachten rechtstreeks in de kaart van het
inspectiebeleid gebruiken. Sommige overeenkomende opdrachten stellen u in staat tekst in een
pakket met een reguliere expressie te identificeren; U kunt bijvoorbeeld URL strings koppelen in
HTTP-pakketten. U kunt reguliere expressies groeperen in een class map met reguliere
expressies (zie de opdracht class-map type regex).

Tabel 1 somt de metacharacters op die speciale betekenis hebben.

kar
akt
er

Beschrijving Opmerkingen

. punt

Overeenkomsten met één teken.
Bijvoorbeeld komt d.g overeen met
hond, dag, dtg, en elk woord dat die
tekens bevat, zoals hondengonnit.

(nl.
)

Subexpress
ie

Een compressie scheidt tekens van
omliggende tekens, zodat u andere
tekens op de onderdrukking kunt
gebruiken. d(o|a)g bijvoorbeeld komt
overeen met hond en dag, maar do|ag
overeenkomsten doen en ag. Er kan
ook een compressie worden gebruikt
met herkende kwantificeringen om een
onderscheid te maken tussen de
tekens die bij een herhaling moeten
worden gebruikt. Bijvoorbeeld, ab (xy)
{3} z past abxyz aan.

| Alternatie

Overeenkomsten van een van beide
expressies die het scheidt.
Bijvoorbeeld hond |cat komt overeen
met hond of kat.

? vraagteken
Een kwanfier die aangeeft dat er 0 of 1
van de vorige expressie is.
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Bijvoorbeeld, zie? Zie
overeenkomsten verloren of verliezen.
Opmerking: U moet Ctrl+V invoeren
en vervolgens het vraagteken of
anders wordt de Help-functie
opgeroepen.

* Asterisk

Een kwantificator die aangeeft dat er
0, 1 of een nummer van de vorige
expressie is. Bijvoorbeeld, zie*se
overeenkomsten minder, verlies, los,
etc.

{x}
Herhaal
kwantificato
r

Doe precies x keer. Bijvoorbeeld, ab
(xy) {3} z past abxyz aan.

{x,}

Minimale
herhalingsk
wantificerin
g

Herhaal dit minstens x keer.
Bijvoorbeeld, ab (xy) {2,} z past abxyz,
abxyxyz, etc. aan.

[ab
c]

Tekenklass
e

Overeenkomt een teken in de haakjes.
Bijvoorbeeld komt [abc] overeen met
a, b of c.

[^a
bc]

Negatieve
tekenklasse

Overeenkomsten met één teken dat
niet tussen de haakjes zit.
Bijvoorbeeld, [^abc] komt een ander
teken aan dan a, b of c. [^A-Z] komt
overeen met elk teken dat geen
hoofdletter is.

[a-
c]

Tekenklass
e

Overeenkomst met elk teken in het
bereik. [a-z] komt overeen met elke
kleine letter. U kunt tekens en bereik
samenvoegen: [abcq-z] komt overeen
met a, b, c, q, r, s, t, u, v, w, x, y, z, en
[a-cq-z]. Het streepje (-) teken is alleen
letterlijk als het laatste of eerste teken
binnen de haakjes is: [abc-] of [-abc].

"" Quotentiete
kens

Houdt het tekenen of uitlopen van
spaties in de string vast. De "test"
behoudt bijvoorbeeld de
toonaangevende ruimte wanneer deze
op een match is gericht.

^ ^
^ kleding Specificeert het begin van een regel.

\ Escape-
teken

Bij gebruik met een metacharacter
komt een letterlijk teken overeen.
Bijvoorbeeld \[ komt overeen met de
linkerkant van de beugel.

klu
sje karakter

Wanneer een teken geen
metacharacter is, past het letterlijke
teken aan.

\r wagenoord Komt overeen met een poster.



\n Nieuws Komt overeen met een nieuwe regel
0x0a.

\t Tab Overeenkomsten van een tabblad
0x09.

\f Formulier Komt overeen met een formulierfeed
0x0c.

\xN
N

Escaped
hexadecima
al nummer

Overeenkomst een ASCII-teken met
hexadecimaal (exact twee cijfers).

\N
NN

Verbroken
octaal
nummer

Overeenkomst een ASCII-teken als
octaal (exact drie cijfers). Het teken
040 vertegenwoordigt bijvoorbeeld
een ruimte.

Configureren

Deze sectie bevat informatie over het configureren van de functies die in dit document worden
beschreven.

Opmerking: Gebruik het Opname Gereedschap (alleen geregistreerde klanten) om meer
informatie te verkrijgen over de opdrachten die in deze sectie worden gebruikt.

Netwerkdiagram

Het netwerk in dit document is als volgt opgebouwd:

Configuraties
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Dit document gebruikt deze configuraties:

ASA CLI-configuratie●

ASA configuratie 7.2(x) met ASDM 5.2●

ASA CLI-configuratie

ASA CLI-configuratie

ciscoasa#show running-config

: Saved

:

ASA Version 7.2(2)

!

hostname ciscoasa

domain-name default.domain.invalid

enable password 8Ry2YjIyt7RRXU24 encrypted

names

!

interface Ethernet0/0

 nameif inside

 security-level 100

 ip address 10.1.1.1 255.255.255.0

!

interface Ethernet0/1

 nameif outside

 security-level 0

 ip address 192.168.1.5 255.255.255.0

!

interface Ethernet0/2

 nameif DMZ

 security-level 90

 ip address 10.77.241.142 255.255.255.192

!

interface Ethernet0/3

 shutdown

 no nameif

 no security-level

 no ip address

!

interface Management0/0

 shutdown

 no nameif

 no security-level

 no ip address

!

passwd 2KFQnbNIdI.2KYOU encrypted

regex urllist1

".*\.([Ee][Xx][Ee]|[Cc][Oo][Mm]|[Bb][Aa][Tt])

HTTP/1.[01]"

!--- Extensions such as .exe, .com, .bat to be captured

and !--- provided the http version being used by web

browser must be either 1.0 or 1.1 regex urllist2

".*\.([Pp][Ii][Ff]|[Vv][Bb][Ss]|[Ww][Ss][Hh])

HTTP/1.[01]"

!--- Extensions such as .pif, .vbs, .wsh to be captured

!--- and provided the http version being used by web

browser must be either !--- 1.0 or 1.1 regex urllist3

".*\.([Dd][Oo][Cc]|[Xx][Ll][Ss]|[Pp][Pp][Tt])



HTTP/1.[01]"

!--- Extensions such as .doc(word), .xls(ms-excel), .ppt

to be captured and provided !--- the http version being

used by web browser must be either 1.0 or 1.1 regex

urllist4 ".*\.([Zz][Ii][Pp]|[Tt][Aa][Rr]|[Tt][Gg][Zz])

HTTP/1.[01]"

!--- Extensions such as .zip, .tar, .tgz to be captured

and provided !--- the http version being used by web

browser must be either 1.0 or 1.1 regex domainlist1

"\.yahoo\.com"

regex domainlist2 "\.myspace\.com"

regex domainlist3 "\.youtube\.com"

!--- Captures the URLs with domain name like yahoo.com,

!--- youtube.com and myspace.com regex contenttype

"Content-Type"

regex applicationheader "application/.*"

!--- Captures the application header and type of !---

content in order for analysis boot system disk0:/asa802-

k8.bin ftp mode passive dns server-group DefaultDNS

domain-name default.domain.invalid access-list

inside_mpc extended permit tcp any any eq www

access-list inside_mpc extended permit tcp any any eq

8080

!--- Filters the http and port 8080 !--- traffic in

order to block the specific traffic with regular !---

expressions pager lines 24 mtu inside 1500 mtu outside

1500 mtu DMZ 1500 no failover icmp unreachable rate-

limit 1 burst-size 1 asdm image disk0:/asdm-602.bin no

asdm history enable arp timeout 14400 route DMZ 0.0.0.0

0.0.0.0 10.77.241.129 1 timeout xlate 3:00:00 timeout

conn 1:00:00 half-closed 0:10:00 udp 0:02:00 icmp

0:00:02 timeout sunrpc 0:10:00 h323 0:05:00 h225 1:00:00

mgcp 0:05:00 mgcp-pat 0:05:00 timeout sip 0:30:00

sip_media 0:02:00 sip-invite 0:03:00 sip-disconnect

0:02:00 timeout uauth 0:05:00 absolute dynamic-access-

policy-record DfltAccessPolicy http server enable http

0.0.0.0 0.0.0.0 DMZ no snmp-server location no snmp-

server contact snmp-server enable traps snmp

authentication linkup linkdown coldstart no crypto

isakmp nat-traversal telnet timeout 5 ssh timeout 5

console timeout 0 threat-detection basic-threat threat-

detection statistics access-list ! class-map type regex

match-any DomainBlockList

 match regex domainlist1

 match regex domainlist2

 match regex domainlist3

!--- Class map created in order to match the domain

names !--- to be blocked class-map type inspect http

match-all BlockDomainsClass

 match request header host regex class DomainBlockList

!--- Inspect the identified traffic by class !---

"DomainBlockList" class-map type regex match-any

URLBlockList

 match regex urllist1

 match regex urllist2

 match regex urllist3



 match regex urllist4

!--- Class map created in order to match the URLs !---

to be blocked class-map inspection_default match

default-inspection-traffic class-map type inspect http

match-all AppHeaderClass

 match response header regex contenttype regex

applicationheader

!--- Inspect the captured traffic by regular !---

expressions "content-type" and "applicationheader"

class-map httptraffic

 match access-list inside_mpc

!--- Class map created in order to match the !---

filtered traffic by ACL class-map type inspect http

match-all BlockURLsClass

 match request uri regex class URLBlockList

!

!--- Inspect the identified traffic by class !---

"URLBlockList" ! policy-map type inspect dns

preset_dns_map parameters message-length maximum 512

policy-map type inspect http http_inspection_policy

 parameters

  protocol-violation action drop-connection

 class AppHeaderClass

  drop-connection log

 match request method connect

  drop-connection log

 class BlockDomainsClass

  reset log

 class BlockURLsClass

  reset log

!--- Define the actions such as drop, reset or log !---

in the inspection policy map policy-map global_policy

class inspection_default inspect dns preset_dns_map

inspect ftp inspect h323 h225 inspect h323 ras inspect

netbios inspect rsh inspect rtsp inspect skinny inspect

esmtp inspect sqlnet inspect sunrpc inspect tftp inspect

sip inspect xdmcp policy-map inside-policy

 class httptraffic

  inspect http http_inspection_policy

!--- Map the inspection policy map to the class !---

"httptraffic" under the policy map created for the !---

inside network traffic ! service-policy global_policy

global service-policy inside-policy interface inside

!--- Apply the policy to the interface inside where the

websites will be blocked prompt hostname context

Cryptochecksum:e629251a7c37af205c289cf78629fc11 : end

ciscoasa#

ASA configuratie 7.2(x) met ASDM 5.2

Voltooi deze stappen om de reguliere expressies te configureren en ze toe te passen op MPF om
de specifieke websites te blokkeren:

Reguliere expressies makenKies Configuration > Global Objects > Reguliere expressies en
klik op Add onder het tabblad Reguliere expressie om reguliere expressies te maken.Maak

1.



een platenlijst van reguliere expressies1 om de domeinnaam yahoo.com op te nemen. Klik
op
OK.

Maak een reguliere expressie huislijst2 om de domeinnaam myspace.com op te nemen. Klik
op

OK. M
aak een reguliere expressie huislijst3 om de domeinnaam youtube.com op te nemen. Klik op

OK. M
aak een reguliere expressie urllist1 om de bestandsextensies op te nemen zoals exe, com en



bat op voorwaarde dat de http versie die door de webbrowser wordt gebruikt 1.0 of 1.1 is.
Klik op

OK. Maak
een urllist2 van reguliere expressies om de bestandsextensies op te nemen, zoals pif, vbs en
wsh op voorwaarde dat de HTTP versie die door de webbrowser wordt gebruikt 1.0 of 1.1 is.
Klik op

OK. Maak
een urllist3 van reguliere expressies om de bestandsextensies op te nemen, zoals doc, xls
en ppt op voorwaarde dat de HTTP-versie die door de webbrowser wordt gebruikt 1.0 of 1.1
is. Klik op



OK. Maak
een urllist4 van reguliere expressies om de bestandsextensies op te nemen, zoals zip, tar en
tgz op voorwaarde dat de HTTP-versie die door de webbrowser wordt gebruikt 1.0 of 1.1 is.
Klik op

OK. Ma
ak een inhoud die binnen reguliere expressies valt, om het contenttype op te nemen. Klik op

OK. Maak een
toepassingsheader van reguliere expressies om de verschillende toepassingsheader op te
nemen. Klik op



OK. Compatib
ele CLI-configuratie
Reguliere expressieklasse makenKies Configuration > Global Objects > Reguliere
expressies en klik op Add onder het tabblad Reguliere expressies om de verschillende
klassen te maken.Maak een reguliere expressieklasse DomainBlockList om een van de
reguliere expressies te evenaren: domainlist1, domainlist2, en domainlist3. Klik op
OK.

Maak een expressieklasse URLBlockList zodat deze overeenkomt met een van de reguliere
expressies: urllist1, urllist2, urllist3, en urllist4. Klik op
OK.

2.



Compatibele CLI-configuratie
Controleer het geïdentificeerde verkeer met Klasse mapsKies Configuration > Global Objects
> Class Maps > HTTP > Add om een class map te maken voor het inspecteren van het
HTTP-verkeer dat door verschillende reguliere expressies is geïdentificeerd.Maak een class-
kaart AppHeaderClass om de antwoordheader met reguliere expressies aan te
passen.

3.



Klik op OK.Maak een class map BlockDomainClass om de request header aan te passen
met reguliere
expressies.



Klik op OK.Maak een class map BlockURLsClass om de aanvraag URI met reguliere
expressies aan te
passen.



Klik op OK.Compatibele CLI-configuratie
Vaststellen van de maatregelen voor het gecompenseerde verkeer in het inspectiebeleidKies
Configuration > Global Objects > Inspect Maps > HTTP om een http_inspection_policy te
maken om de actie voor het gematchte verkeer in te stellen. Klik op Toevoegen en
Toepassen.

Kies Configuration > Global Objects > Inspect Maps > HTTP > http_inspection_policy en klik
op Advanced View > Inspections > Add om de acties voor de verschillende klassen in te
stellen die tot nu toe zijn
gemaakt.

4.



Klik op OK.Stel de actie in als Drop Connection; Schakel de vastlegging voor het criterium in
als aanvraagmethode en waarde in als



verbinding. Klik op
OK.Stel de actie in als Drop Connection en Schakel de vastlegging in voor de klasse



AppHeaderClass. K
lik op OK.Stel de actie in als Reset en Schakel de vastlegging in voor de class
BlockDomainClass.



Klik op OK.Stel
de actie in als Reset en Schakel de vastlegging in voor de class

BlockURLsClass. Klik op
OK.Klik op Toepassen.Compatibele CLI-configuratie
Pas het http-beleid op de interface toeKies Configuration > Security Policy > Service Policy
Rules > Add > Service Policy Rule onder het tabblad

5.



Servicebeleid.

HTTP-verkeerKies de knop Interface met de interne interface in het vervolgkeuzemenu en de
beleidsnaam als binnenbeleid. Klik op
Volgende.

Maak een class map httptraffic en controleer het IP-adres van bron en bestemming (gebruik
ACL). Klik op
Volgende.



Kies de Bron en de Bestemming zoals elk met de TCP poort als HTTP. Klik op
Volgende.



Controleer de HTTP-radioknop en klik op

Configureren. Controleer de radioknop
Selecteer een HTTP inspectiekaart voor de controle op de inspectie. Klik op



OK. Klik op
Voltooien.

Port 8080-verkeerKlik nogmaals op Add > Add Service Policy
Rule.



Klik op
Volgende.

Kies
de radioknop Toevoegen aan bestaande verkeersklasse en kies httptraffic in het
vervolgkeuzemenu. Klik op
Volgende.



Kies de bron en de bestemming zoals elk met de TCP-poort als 8080. Klik op
Volgende.



Klik op
Voltooien.



Klik op Toepassen.Compatibele CLI-configuratie

Verifiëren



Gebruik dit gedeelte om te bevestigen dat de configuratie correct werkt.

Het Uitvoer Tolk (uitsluitend geregistreerde klanten) (OIT) ondersteunt bepaalde show opdrachten.
Gebruik de OIT om een analyse van tonen opdrachtoutput te bekijken.

tonen in werking stellen-in werking stellen regex-Toont de regelmatige expressies die zijn
gevormd
ciscoasa#show running-config regex

regex urllist1 ".*\.([Ee][Xx][Ee]|[Cc][Oo][Mm]|[Bb][Aa][Tt]) HTTP/1.[01]"

regex urllist2 ".*\.([Pp][Ii][Ff]|[Vv][Bb][Ss]|[Ww][Ss][Hh]) HTTP/1.[01]"

regex urllist3 ".*\.([Dd][Oo][Cc]|[Xx][Ll][Ss]|[Pp][Pp][Tt]) HTTP/1.[01]"

regex urllist4 ".*\.([Zz][Ii][Pp]|[Tt][Aa][Rr]|[Tt][Gg][Zz]) HTTP/1.[01]"

regex domainlist1 "\.yahoo\.com"

regex domainlist2 "\.myspace\.com"

regex domainlist3 "\.youtube\.com"

regex contenttype "Content-Type"

regex applicationheader "application/.*"

ciscoasa#

●

toon in werking stellen-in werking stellen-enig klembord-toont de class kaarten die zijn
gevormd
ciscoasa#show running-config class-map

!

class-map type regex match-any DomainBlockList

 match regex domainlist1

 match regex domainlist2

 match regex domainlist3

class-map type inspect http match-all BlockDomainsClass

 match request header host regex class DomainBlockList

class-map type regex match-any URLBlockList

 match regex urllist1

 match regex urllist2

 match regex urllist3

 match regex urllist4

class-map inspection_default

 match default-inspection-traffic

class-map type inspect http match-all AppHeaderClass

 match response header regex contenttype regex applicationheader

class-map httptraffic

 match access-list inside_mpc

class-map type inspect http match-all BlockURLsClass

 match request uri regex class URLBlockList

!

ciscoasa#

●

toon in werking stellen-enig beleid-in kaart type inspectie http—toont de beleidskaarten die het
http verkeer inspecteren dat is gevormd
ciscoasa#show running-config policy-map type inspect http

!

policy-map type inspect http http_inspection_policy

 parameters

  protocol-violation action drop-connection

 class AppHeaderClass

  drop-connection log

 match request method connect

  drop-connection log

 class BlockDomainsClass

  reset log

 class BlockURLsClass

  reset log

!

ciscoasa#

●
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toon in werking stellen-beslist politiek-kaart-toont alle beleid-kaart configuraties evenals de
standaard beleid-kaart configuratie
ciscoasa#show running-config policy-map

!

policy-map type inspect dns preset_dns_map

 parameters

  message-length maximum 512

policy-map type inspect http http_inspection_policy

 parameters

  protocol-violation action drop-connection

 class AppHeaderClass

  drop-connection log

 match request method connect

  drop-connection log

 class BlockDomainsClass

  reset log

 class BlockURLsClass

  reset log

policy-map global_policy

 class inspection_default

  inspect dns preset_dns_map

  inspect ftp

  inspect h323 h225

  inspect h323 ras

  inspect netbios

  inspect rsh

  inspect rtsp

  inspect skinny

  inspect esmtp

  inspect sqlnet

  inspect sunrpc

  inspect tftp

  inspect sip

  inspect xdmcp

policy-map inside-policy

 class httptraffic

  inspect http http_inspection_policy

!

ciscoasa#

●

toon in werking stellen-klaar dienst-beleid-Beeldingen alle momenteel in werking gestelde de
dienstbeleidsconfiguraties
ciscoasa#show running-config service-policy

service-policy global_policy global

service-policy inside-policy interface inside

●

Toon in werking stellen-beslist toegang-lijst-Toont de toegang-lijst configuratie die op het
veiligheidsapparaat loopt
ciscoasa#show running-config access-list

access-list inside_mpc extended permit tcp any any eq www

access-list inside_mpc extended permit tcp any any eq 8080

ciscoasa#

●

Problemen oplossen

Deze sectie bevat informatie waarmee u problemen met de configuratie kunt oplossen.

Opmerking: Raadpleeg Belangrijke informatie over debug Commands voordat u debug-
opdrachten gebruikt.

//www.cisco.com/en/US/tech/tk801/tk379/technologies_tech_note09186a008017874c.shtml


   

debug http—toont de debug-berichten voor HTTP-verkeer.●

Gerelateerde informatie

Ondersteuning van Cisco adaptieve security applicatie●

Ondersteuning van Cisco Adapter Security Apparaat Manager (ASDM) pagina●

Cisco 500 Series PIX-ondersteuningspagina●

Technische ondersteuning en documentatie – Cisco Systems●

//www.cisco.com/en/US/products/ps6120/tsd_products_support_series_home.html?referring_site=bodynav
//www.cisco.com/en/US/products/ps6121/tsd_products_support_series_home.html?referring_site=bodynav
//www.cisco.com/en/US/products/hw/vpndevc/ps2030/tsd_products_support_eol_series_home.html?referring_site=bodynav
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